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This document describes the R&S®SGS100A, stock no. 1416.0505.02 and its
options.

The firmware of the instrument makes use of the operating system LINUX® and other valuable open source
software packages. The most important of them together with their corresponding open source license and
the verbatim license texts are provided on the user documentation CD-ROM (included in delivery).
The OpenSSL Project for use in the OpenSSL Toolkit (http://www.openssl.org/) includes cryptographic soft-
ware written by Eric Young (eay@cryptsoft.com) and software written by Tim Hudson (tjh@cryptsoft.com).
LINUX® is a trademark of Linus Torvalds.
Rohde & Schwarz would like to thank the open source community for their valuable contribution to embedded
computing.

© 2012 Rohde & Schwarz GmbH & Co. KG
Muehldorfstr. 15, 81671 Munich, Germany
Phone: +49 89 41 29 - 0
Fax: +49 89 41 29 12 164
E-mail: info@rohde-schwarz.com
Internet: http://www.rohde-schwarz.com
Printed in Germany – Subject to change – Data without tolerance limits is not binding.
R&S® is a registered trademark of Rohde & Schwarz GmbH & Co. KG.
Trade names are trademarks of the owners.

The following abbreviations are used throughout this manual: R&S®SGS100A is abbreviated as R&S SGS,
R&S®SGMA-GUI is abbreviated as R&S SGMA-GUI.
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mailto:info@rohde-schwarz.com
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Basic Safety Instructions 
Always read through and comply with the following safety instructions! 

All plants and locations of the Rohde & Schwarz group of companies make every effort to keep the safety 
standards of our products up to date and to offer our customers the highest possible degree of safety. Our 
products and the auxiliary equipment they require are designed, built and tested in accordance with the 
safety standards that apply in each case. Compliance with these standards is continuously monitored by 
our quality assurance system. The product described here has been designed, built and tested in 
accordance with the attached EC Certificate of Conformity and has left the manufacturer’s plant in a 
condition fully complying with safety standards. To maintain this condition and to ensure safe operation, 
you must observe all instructions and warnings provided in this manual. If you have any questions 
regarding these safety instructions, the Rohde & Schwarz group of companies will be happy to answer 
them. 

Furthermore, it is your responsibility to use the product in an appropriate manner. This product is designed 
for use solely in industrial and laboratory environments or, if expressly permitted, also in the field and must 
not be used in any way that may cause personal injury or property damage. You are responsible if the 
product is used for any purpose other than its designated purpose or in disregard of the manufacturer's 
instructions. The manufacturer shall assume no responsibility for such use of the product.  

The product is used for its designated purpose if it is used in accordance with its product documentation 
and within its performance limits (see data sheet, documentation, the following safety instructions). Using 
the product requires technical skills and, in some cases, a basic knowledge of English. It is therefore 
essential that only skilled and specialized staff or thoroughly trained personnel with the required skills be 
allowed to use the product. If personal safety gear is required for using Rohde & Schwarz products, this 
will be indicated at the appropriate place in the product documentation. Keep the basic safety instructions 
and the product documentation in a safe place and pass them on to the subsequent users. 

Observing the safety instructions will help prevent personal injury or damage of any kind caused by 
dangerous situations. Therefore, carefully read through and adhere to the following safety instructions 
before and when using the product. It is also absolutely essential to observe the additional safety 
instructions on personal safety, for example, that appear in relevant parts of the product documentation. In 
these safety instructions, the word "product" refers to all merchandise sold and distributed by the Rohde & 
Schwarz group of companies, including instruments, systems and all accessories. For product-specific 
information, see the data sheet and the product documentation. 

Symbols and safety labels 

Symbol Meaning Symbol Meaning 

Notice, general danger location 

Observe product documentation 

ON/OFF supply voltage 

Caution when handling heavy equipment Standby indication 

Danger of electric shock Direct current (DC) 
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Symbol Meaning Symbol Meaning 

Warning! Hot surface Alternating current (AC) 

Protective conductor terminal Direct/alternating current (DC/AC) 

Ground Device fully protected by double (reinforced) 
insulation 

Ground terminal EU labeling for batteries and accumulators 

For additional information, see section "Waste 
disposal/Environmental protection", item 1. 

Be careful when handling electrostatic sensitive 
devices 

EU labeling for separate collection of electrical 
and electronic devices 

For additonal information, see section "Waste 
disposal/Environmental protection", item 2. 

Warning! Laser radiation 

For additional information, see section 
"Operation", item 7. 

 

Signal words and their meaning 

The following signal words are used in the product documentation in order to warn the reader about risks 
and dangers. 

Indicates an imminently hazardous situation which, if not avoided, will result 
in death or serious injury. 

Indicates a potentially hazardous situation which, if not avoided, could result 
in death or serious injury. 

Indicates a potentially hazardous situation which, if not avoided, could result 
in minor or moderate injury. 

Indicates the possibility of incorrect operation which can result in damage to 
the product.  
In the product documentation, the word ATTENTION is used synonymously.  

 
These signal words are in accordance with the standard definition for civil applications in the European 
Economic Area. Definitions that deviate from the standard definition may also exist in other economic 
areas or military applications. It is therefore essential to make sure that the signal words described here 
are always used only in connection with the related product documentation and the related product. The 
use of signal words in connection with unrelated products or documentation can result in misinterpretation 
and in personal injury or material damage. 
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Operating states and operating positions 

The product may be operated only under the operating conditions and in the positions specified by the 
manufacturer, without the product's ventilation being obstructed. If the manufacturer's specifications are 
not observed, this can result in electric shock, fire and/or serious personal injury or death. Applicable local 
or national safety regulations and rules for the prevention of accidents must be observed in all work 
performed.  

1. Unless otherwise specified, the following requirements apply to Rohde & Schwarz products:  
predefined operating position is always with the housing floor facing down, IP protection 2X, use only 
indoors, max. operating altitude 2000 m above sea level, max. transport altitude 4500 m above sea 
level. A tolerance of ±10 % shall apply to the nominal voltage and ±5 % to the nominal frequency, 
overvoltage category 2, pollution severity 2. 

2. Do not place the product on surfaces, vehicles, cabinets or tables that for reasons of weight or stability 
are unsuitable for this purpose. Always follow the manufacturer's installation instructions when 
installing the product and fastening it to objects or structures (e.g. walls and shelves). An installation 
that is not carried out as described in the product documentation could result in personal injury or 
even death. 

3. Do not place the product on heat-generating devices such as radiators or fan heaters. The ambient 
temperature must not exceed the maximum temperature specified in the product documentation or in 
the data sheet. Product overheating can cause electric shock, fire and/or serious personal injury or 
even death. 

Electrical safety 

If the information on electrical safety is not observed either at all or to the extent necessary, electric shock, 
fire and/or serious personal injury or death may occur.  

1. Prior to switching on the product, always ensure that the nominal voltage setting on the product 
matches the nominal voltage of the AC supply network. If a different voltage is to be set, the power 
fuse of the product may have to be changed accordingly.  

2. In the case of products of safety class I with movable power cord and connector, operation is 
permitted only on sockets with a protective conductor contact and protective conductor. 

3. Intentionally breaking the protective conductor either in the feed line or in the product itself is not 
permitted. Doing so can result in the danger of an electric shock from the product. If extension cords 
or connector strips are implemented, they must be checked on a regular basis to ensure that they are 
safe to use. 

4. If there is no power switch for disconnecting the product from the AC supply network, or if the power 
switch is not suitable for this purpose, use the plug of the connecting cable to disconnect the product 
from the AC supply network. In such cases, always ensure that the power plug is easily reachable and 
accessible at all times. For example, if the power plug is the disconnecting device, the length of the 
connecting cable must not exceed 3 m. Functional or electronic switches are not suitable for providing 
disconnection from the AC supply network. If products without power switches are integrated into 
racks or systems, the disconnecting device must be provided at the system level. 

5. Never use the product if the power cable is damaged. Check the power cables on a regular basis to 
ensure that they are in proper operating condition. By taking appropriate safety measures and 
carefully laying the power cable, ensure that the cable cannot be damaged and that no one can be 
hurt by, for example, tripping over the cable or suffering an electric shock.  
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6. The product may be operated only from TN/TT supply networks fuse-protected with max. 16 A (higher 
fuse only after consulting with the Rohde & Schwarz group of companies). 

7. Do not insert the plug into sockets that are dusty or dirty. Insert the plug firmly and all the way into the 
socket provided for this purpose. Otherwise, sparks that result in fire and/or injuries may occur.  

8. Do not overload any sockets, extension cords or connector strips; doing so can cause fire or electric 
shocks. 

9. For measurements in circuits with voltages Vrms > 30 V, suitable measures (e.g. appropriate 
measuring equipment, fuse protection, current limiting, electrical separation, insulation) should be 
taken to avoid any hazards. 

10. Ensure that the connections with information technology equipment, e.g. PCs or other industrial 
computers, comply with the IEC60950-1/EN60950-1 or IEC61010-1/EN 61010-1 standards that apply 
in each case. 

11. Unless expressly permitted, never remove the cover or any part of the housing while the product is in 
operation. Doing so will expose circuits and components and can lead to injuries, fire or damage to the 
product. 

12. If a product is to be permanently installed, the connection between the protective conductor terminal 
on site and the product's protective conductor must be made first before any other connection is 
made. The product may be installed and connected only by a licensed electrician. 

13. For permanently installed equipment without built-in fuses, circuit breakers or similar protective 
devices, the supply circuit must be fuse-protected in such a way that anyone who has access to the 
product, as well as the product itself, is adequately protected from injury or damage. 

14. Use suitable overvoltage protection to ensure that no overvoltage (such as that caused by a bolt of 
lightning) can reach the product. Otherwise, the person operating the product will be exposed to the 
danger of an electric shock. 

15. Any object that is not designed to be placed in the openings of the housing must not be used for this 
purpose. Doing so can cause short circuits inside the product and/or electric shocks, fire or injuries. 

16. Unless specified otherwise, products are not liquid-proof (see also section "Operating states and 
operating positions", item 1). Therefore, the equipment must be protected against penetration by 
liquids. If the necessary precautions are not taken, the user may suffer electric shock or the product 
itself may be damaged, which can also lead to personal injury. 

17. Never use the product under conditions in which condensation has formed or can form in or on the 
product, e.g. if the product has been moved from a cold to a warm environment. Penetration by water 
increases the risk of electric shock. 

18. Prior to cleaning the product, disconnect it completely from the power supply (e.g. AC supply network 
or battery). Use a soft, non-linting cloth to clean the product. Never use chemical cleaning agents such 
as alcohol, acetone or diluents for cellulose lacquers. 

Operation 

1. Operating the products requires special training and intense concentration. Make sure that persons 
who use the products are physically, mentally and emotionally fit enough to do so; otherwise, injuries 
or material damage may occur. It is the responsibility of the employer/operator to select suitable 
personnel for operating the products. 
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2. Before you move or transport the product, read and observe the section titled "Transport". 

3. As with all industrially manufactured goods, the use of substances that induce an allergic reaction 
(allergens) such as nickel cannot be generally excluded. If you develop an allergic reaction (such as a 
skin rash, frequent sneezing, red eyes or respiratory difficulties) when using a Rohde & Schwarz 
product, consult a physician immediately to determine the cause and to prevent health problems or 
stress.  

4. Before you start processing the product mechanically and/or thermally, or before you take it apart, be 
sure to read and pay special attention to the section titled "Waste disposal/Environmental protection", 
item 1. 

5. Depending on the function, certain products such as RF radio equipment can produce an elevated 
level of electromagnetic radiation. Considering that unborn babies require increased protection, 
pregnant women must be protected by appropriate measures. Persons with pacemakers may also be 
exposed to risks from electromagnetic radiation. The employer/operator must evaluate workplaces 
where there is a special risk of exposure to radiation and, if necessary, take measures to avert the 
potential danger. 

6. Should a fire occur, the product may release hazardous substances (gases, fluids, etc.) that can 
cause health problems. Therefore, suitable measures must be taken, e.g. protective masks and 
protective clothing must be worn. 

7. Laser products are given warning labels that are standardized according to their laser class. Lasers 
can cause biological harm due to the properties of their radiation and due to their extremely 
concentrated electromagnetic power. If a laser product (e.g. a CD/DVD drive) is integrated into a 
Rohde & Schwarz product, absolutely no other settings or functions may be used as described in the 
product documentation. The objective is to prevent personal injury (e.g. due to laser beams). 

8. EMC classes (in line with CISPR 11) 
Class A: Equipment suitable for use in all environments except residential environments and 
environments that are directly connected to a low-voltage supply network that supplies residential 
buildings. 
Class B: Equipment suitable for use in residential environments and environments that are directly 
connected to a low-voltage supply network that supplies residential buildings. 

Repair and service 

1. The product may be opened only by authorized, specially trained personnel. Before any work is 
performed on the product or before the product is opened, it must be disconnected from the AC supply 
network. Otherwise, personnel will be exposed to the risk of an electric shock.  

2. Adjustments, replacement of parts, maintenance and repair may be performed only by electrical 
experts authorized by Rohde & Schwarz. Only original parts may be used for replacing parts relevant 
to safety (e.g. power switches, power transformers, fuses). A safety test must always be performed 
after parts relevant to safety have been replaced (visual inspection, protective conductor test, 
insulation resistance measurement, leakage current measurement, functional test). This helps ensure 
the continued safety of the product.  
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Batteries and rechargeable batteries/cells 

If the information regarding batteries and rechargeable batteries/cells is not observed either at all or to the 
extent necessary, product users may be exposed to the risk of explosions, fire and/or serious personal 
injury, and, in some cases, death. Batteries and rechargeable batteries with alkaline electrolytes (e.g. 
lithium cells) must be handled in accordance with the EN 62133 standard. 

1. Cells must not be taken apart or crushed.  

2. Cells or batteries must not be exposed to heat or fire. Storage in direct sunlight must be avoided. 
Keep cells and batteries clean and dry. Clean soiled connectors using a dry, clean cloth. 

3. Cells or batteries must not be short-circuited. Cells or batteries must not be stored in a box or in a 
drawer where they can short-circuit each other, or where they can be short-circuited by other 
conductive materials. Cells and batteries must not be removed from their original packaging until they 
are ready to be used. 

4. Cells and batteries must not be exposed to any mechanical shocks that are stronger than permitted. 

5. If a cell develops a leak, the fluid must not be allowed to come into contact with the skin or eyes. If 
contact occurs, wash the affected area with plenty of water and seek medical aid. 

6. Improperly replacing or charging cells or batteries that contain alkaline electrolytes (e.g. lithium cells) 
can cause explosions. Replace cells or batteries only with the matching Rohde & Schwarz type (see 
parts list) in order to ensure the safety of the product.  

7. Cells and batteries must be recycled and kept separate from residual waste. Rechargeable batteries 
and normal batteries that contain lead, mercury or cadmium are hazardous waste. Observe the 
national regulations regarding waste disposal and recycling.  

Transport 

1. The product may be very heavy. Therefore, the product must be handled with care. In some cases, 
the user may require a suitable means of lifting or moving the product (e.g. with a lift-truck) to avoid 
back or other physical injuries.  

2. Handles on the products are designed exclusively to enable personnel to transport the product. It is 
therefore not permissible to use handles to fasten the product to or on transport equipment such as 
cranes, fork lifts, wagons, etc. The user is responsible for securely fastening the products to or on the 
means of transport or lifting. Observe the safety regulations of the manufacturer of the means of 
transport or lifting. Noncompliance can result in personal injury or material damage. 

3. If you use the product in a vehicle, it is the sole responsibility of the driver to drive the vehicle safely 
and properly. The manufacturer assumes no responsibility for accidents or collisions. Never use the 
product in a moving vehicle if doing so could distract the driver of the vehicle. Adequately secure the 
product in the vehicle to prevent injuries or other damage in the event of an accident.  

Waste disposal/Environmental protection 

1. Specially marked equipment has a battery or accumulator that must not be disposed of with unsorted 
municipal waste, but must be collected separately. It may only be disposed of at a suitable collection 
point or via a Rohde & Schwarz customer service center. 
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2. Waste electrical and electronic equipment must not be disposed of with unsorted municipal waste, but 
must be collected separately. 
Rohde & Schwarz GmbH & Co. KG has developed a disposal concept and takes full responsibility for 
take-back obligations and disposal obligations for manufacturers within the EU. Contact your 
Rohde & Schwarz customer service center for environmentally responsible disposal of the product. 

3. If products or their components are mechanically and/or thermally processed in a manner that goes 
beyond their intended use, hazardous substances (heavy-metal dust such as lead, beryllium, nickel) 
may be released. For this reason, the product may only be disassembled by specially trained 
personnel. Improper disassembly may be hazardous to your health. National waste disposal 
regulations must be observed.  

4. If handling the product releases hazardous substances or fuels that must be disposed of in a special 
way, e.g. coolants or engine oils that must be replenished regularly, the safety instructions of the 
manufacturer of the hazardous substances or fuels and the applicable regional waste disposal 
regulations must be observed. Also observe the relevant safety instructions in the product 
documentation. The improper disposal of hazardous substances or fuels can cause health problems 
and lead to environmental damage. 

For additional information about environmental protection, visit the Rohde & Schwarz website. 

Instrucciones de seguridad elementales 
¡Es imprescindible leer y cumplir las siguientes instrucciones e informaciones de seguridad! 

El principio del grupo de empresas Rohde & Schwarz consiste en tener nuestros productos siempre al día 
con los estándares de seguridad y de ofrecer a nuestros clientes el máximo grado de seguridad. Nuestros 
productos y todos los equipos adicionales son siempre fabricados y examinados según las normas de 
seguridad vigentes. Nuestro sistema de garantía de calidad controla constantemente que sean cumplidas 
estas normas. El presente producto ha sido fabricado y examinado según el certificado de conformidad 
adjunto de la UE y ha salido de nuestra planta en estado impecable según los estándares técnicos de 
seguridad. Para poder preservar este estado y garantizar un funcionamiento libre de peligros, el usuario 
deberá atenerse a todas las indicaciones, informaciones de seguridad y notas de alerta. El grupo de 
empresas Rohde & Schwarz está siempre a su disposición en caso de que tengan preguntas referentes a 
estas informaciones de seguridad. 

Además queda en la responsabilidad del usuario utilizar el producto en la forma debida. Este producto 
está destinado exclusivamente al uso en la industria y el laboratorio o, si ha sido expresamente 
autorizado, para aplicaciones de campo y de ninguna manera deberá ser utilizado de modo que alguna 
persona/cosa pueda sufrir daño. El uso del producto fuera de sus fines definidos o sin tener en cuenta las 
instrucciones del fabricante queda en la responsabilidad del usuario. El fabricante no se hace en ninguna 
forma responsable de consecuencias a causa del mal uso del producto.  
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Se parte del uso correcto del producto para los fines definidos si el producto es utilizado conforme a las 
indicaciones de la correspondiente documentación del producto y dentro del margen de rendimiento 
definido (ver hoja de datos, documentación, informaciones de seguridad que siguen). El uso del producto 
hace necesarios conocimientos técnicos y ciertos conocimientos del idioma inglés. Por eso se debe tener 
en cuenta que el producto solo pueda ser operado por personal especializado o personas instruidas en 
profundidad con las capacidades correspondientes. Si fuera necesaria indumentaria de seguridad para el 
uso de productos de Rohde & Schwarz, encontraría la información debida en la documentación del 
producto en el capítulo correspondiente. Guarde bien las informaciones de seguridad elementales, así 
como la documentación del producto, y entréguelas a usuarios posteriores. 

Tener en cuenta las informaciones de seguridad sirve para evitar en lo posible lesiones o daños por 
peligros de toda clase. Por eso es imprescindible leer detalladamente y comprender por completo las 
siguientes informaciones de seguridad antes de usar el producto, y respetarlas durante el uso del 
producto. Deberán tenerse en cuenta todas las demás informaciones de seguridad, como p. ej. las 
referentes a la protección de personas, que encontrarán en el capítulo correspondiente de la 
documentación del producto y que también son de obligado cumplimiento. En las presentes 
informaciones de seguridad se recogen todos los objetos que distribuye el grupo de empresas 
Rohde & Schwarz bajo la denominación de "producto", entre ellos también aparatos, instalaciones así 
como toda clase de accesorios. Los datos específicos del producto figuran en la hoja de datos y en la 
documentación del producto. 

Símbolos y definiciones de seguridad 

Símbolo Significado Símbolo Significado 

Aviso: punto de peligro general 

Observar la documentación del producto 

Tensión de alimentación de PUESTA EN 
MARCHA / PARADA 

Atención en el manejo de dispositivos de peso 
elevado 

Indicación de estado de espera (standby) 

Peligro de choque eléctrico Corriente continua (DC) 

Advertencia: superficie caliente Corriente alterna (AC) 

Conexión a conductor de protección Corriente continua / Corriente alterna (DC/AC) 

Conexión a tierra El aparato está protegido en su totalidad por un 
aislamiento doble (reforzado) 

Conexión a masa Distintivo de la UE para baterías y 
acumuladores 

Más información en la sección 
"Eliminación/protección del medio ambiente", 
punto 1. 
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Símbolo Significado Símbolo Significado 

Aviso: Cuidado en el manejo de dispositivos 
sensibles a la electrostática (ESD) 

Distintivo de la UE para la eliminación por 
separado de dispositivos eléctricos y 
electrónicos 

Más información en la sección 
"Eliminación/protección del medio ambiente", 
punto 2. 

Advertencia: rayo láser 

Más información en la sección 
"Funcionamiento", punto 7. 

 

Palabras de señal y su significado 

En la documentación del producto se utilizan las siguientes palabras de señal con el fin de advertir contra 
riesgos y peligros. 

PELIGRO identifica un peligro inminente con riesgo elevado que 
provocará muerte o lesiones graves si no se evita.  

ADVERTENCIA identifica un posible peligro con riesgo medio de 
provocar muerte o lesiones (graves) si no se evita. 

ATENCIÓN identifica un peligro con riesgo reducido de provocar 
lesiones leves o moderadas si no se evita. 

AVISO indica la posibilidad de utilizar mal el producto y, como 
consecuencia, dañarlo. 
En la documentación del producto se emplea de forma sinónima el 
término CUIDADO. 

 
Las palabras de señal corresponden a la definición habitual para aplicaciones civiles en el área 
económica europea. Pueden existir definiciones diferentes a esta definición en otras áreas económicas o 
en aplicaciones militares. Por eso se deberá tener en cuenta que las palabras de señal aquí descritas 
sean utilizadas siempre solamente en combinación con la correspondiente documentación del producto y 
solamente en combinación con el producto correspondiente. La utilización de las palabras de señal en 
combinación con productos o documentaciones que no les correspondan puede llevar a interpretaciones 
equivocadas y tener por consecuencia daños en personas u objetos. 

Estados operativos y posiciones de funcionamiento 

El producto solamente debe ser utilizado según lo indicado por el fabricante respecto a los estados 
operativos y posiciones de funcionamiento sin que se obstruya la ventilación. Si no se siguen las 
indicaciones del fabricante, pueden producirse choques eléctricos, incendios y/o lesiones graves con 
posible consecuencia de muerte. En todos los trabajos deberán ser tenidas en cuenta las normas 
nacionales y locales de seguridad del trabajo y de prevención de accidentes.  
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1. Si no se convino de otra manera, es para los productos Rohde & Schwarz válido lo que sigue:  
como posición de funcionamiento se define por principio la posición con el suelo de la caja para 
abajo, modo de protección IP 2X, uso solamente en estancias interiores, utilización hasta 2000 m 
sobre el nivel del mar, transporte hasta 4500 m sobre el nivel del mar. Se aplicará una tolerancia de 
±10 % sobre el voltaje nominal y de ±5 % sobre la frecuencia nominal. Categoría de sobrecarga 
eléctrica 2, índice de suciedad 2.  

2. No sitúe el producto encima de superficies, vehículos, estantes o mesas, que por sus características 
de peso o de estabilidad no sean aptos para él. Siga siempre las instrucciones de instalación del 
fabricante cuando instale y asegure el producto en objetos o estructuras (p. ej. paredes y estantes). Si 
se realiza la instalación de modo distinto al indicado en la documentación del producto, se pueden 
causar lesiones o, en determinadas circunstancias, incluso la muerte. 

3. No ponga el producto sobre aparatos que generen calor (p. ej. radiadores o calefactores). La 
temperatura ambiente no debe superar la temperatura máxima especificada en la documentación del 
producto o en la hoja de datos. En caso de sobrecalentamiento del producto, pueden producirse 
choques eléctricos, incendios y/o lesiones graves con posible consecuencia de muerte. 

Seguridad eléctrica 

Si no se siguen (o se siguen de modo insuficiente) las indicaciones del fabricante en cuanto a seguridad 
eléctrica, pueden producirse choques eléctricos, incendios y/o lesiones graves con posible consecuencia 
de muerte.  

1. Antes de la puesta en marcha del producto se deberá comprobar siempre que la tensión 
preseleccionada en el producto coincida con la de la red de alimentación eléctrica. Si es necesario 
modificar el ajuste de tensión, también se deberán cambiar en caso dado los fusibles 
correspondientes del producto.  

2. Los productos de la clase de protección I con alimentación móvil y enchufe individual solamente 
podrán enchufarse a tomas de corriente con contacto de seguridad y con conductor de protección 
conectado. 

3. Queda prohibida la interrupción intencionada del conductor de protección, tanto en la toma de 
corriente como en el mismo producto. La interrupción puede tener como consecuencia el riesgo de 
que el producto sea fuente de choques eléctricos. Si se utilizan cables alargadores o regletas de 
enchufe, deberá garantizarse la realización de un examen regular de los mismos en cuanto a su 
estado técnico de seguridad. 

4. Si el producto no está equipado con un interruptor para desconectarlo de la red, o bien si el 
interruptor existente no resulta apropiado para la desconexión de la red, el enchufe del cable de 
conexión se deberá considerar como un dispositivo de desconexión.  
El dispositivo de desconexión se debe poder alcanzar fácilmente y debe estar siempre bien accesible. 
Si, p. ej., el enchufe de conexión a la red es el dispositivo de desconexión, la longitud del cable de 
conexión no debe superar 3 m).  
Los interruptores selectores o electrónicos no son aptos para el corte de la red eléctrica. Si se 
integran productos sin interruptor en bastidores o instalaciones, se deberá colocar el interruptor en el 
nivel de la instalación. 

5. No utilice nunca el producto si está dañado el cable de conexión a red. Compruebe regularmente el 
correcto estado de los cables de conexión a red. Asegúrese, mediante las medidas de protección y 
de instalación adecuadas, de que el cable de conexión a red no pueda ser dañado o de que nadie 
pueda ser dañado por él, p. ej. al tropezar o por un choque eléctrico.  
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6. Solamente está permitido el funcionamiento en redes de alimentación TN/TT aseguradas con fusibles 
de 16 A como máximo (utilización de fusibles de mayor amperaje solo previa consulta con el grupo de 
empresas Rohde & Schwarz). 

7. Nunca conecte el enchufe en tomas de corriente sucias o llenas de polvo. Introduzca el enchufe por 
completo y fuertemente en la toma de corriente. La no observación de estas medidas puede provocar 
chispas, fuego y/o lesiones. 

8. No sobrecargue las tomas de corriente, los cables alargadores o las regletas de enchufe ya que esto 
podría causar fuego o choques eléctricos. 

9. En las mediciones en circuitos de corriente con una tensión Ueff > 30 V se deberán tomar las medidas 
apropiadas para impedir cualquier peligro (p. ej. medios de medición adecuados, seguros, limitación 
de tensión, corte protector, aislamiento etc.). 

10. Para la conexión con dispositivos informáticos como un PC o un ordenador industrial, debe 
comprobarse que éstos cumplan los estándares IEC60950-1/EN60950-1 o IEC61010-1/EN 61010-1 
válidos en cada caso. 

11. A menos que esté permitido expresamente, no retire nunca la tapa ni componentes de la carcasa 
mientras el producto esté en servicio. Esto pone a descubierto los cables y componentes eléctricos y 
puede causar lesiones, fuego o daños en el producto. 

12. Si un producto se instala en un lugar fijo, se deberá primero conectar el conductor de protección fijo 
con el conductor de protección del producto antes de hacer cualquier otra conexión. La instalación y 
la conexión deberán ser efectuadas por un electricista especializado. 

13. En el caso de dispositivos fijos que no estén provistos de fusibles, interruptor automático ni otros 
mecanismos de seguridad similares, el circuito de alimentación debe estar protegido de modo que 
todas las personas que puedan acceder al producto, así como el producto mismo, estén a salvo de 
posibles daños. 

14. Todo producto debe estar protegido contra sobretensión (debida p. ej. a una caída del rayo) mediante 
los correspondientes sistemas de protección. Si no, el personal que lo utilice quedará expuesto al 
peligro de choque eléctrico. 

15. No debe introducirse en los orificios de la caja del aparato ningún objeto que no esté destinado a ello. 
Esto puede producir cortocircuitos en el producto y/o puede causar choques eléctricos, fuego o 
lesiones. 

16. Salvo indicación contraria, los productos no están impermeabilizados (ver también el capítulo 
"Estados operativos y posiciones de funcionamiento", punto 1). Por eso es necesario tomar las 
medidas necesarias para evitar la entrada de líquidos. En caso contrario, existe peligro de choque 
eléctrico para el usuario o de daños en el producto, que también pueden redundar en peligro para las 
personas. 

17. No utilice el producto en condiciones en las que pueda producirse o ya se hayan producido 
condensaciones sobre el producto o en el interior de éste, como p. ej. al desplazarlo de un lugar frío a 
otro caliente. La entrada de agua aumenta el riesgo de choque eléctrico. 

18. Antes de la limpieza, desconecte por completo el producto de la alimentación de tensión (p. ej. red de 
alimentación o batería). Realice la limpieza de los aparatos con un paño suave, que no se deshilache. 
No utilice bajo ningún concepto productos de limpieza químicos como alcohol, acetona o diluyentes 
para lacas nitrocelulósicas. 
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Funcionamiento 

1. El uso del producto requiere instrucciones especiales y una alta concentración durante el manejo. 
Debe asegurarse que las personas que manejen el producto estén a la altura de los requerimientos 
necesarios en cuanto a aptitudes físicas, psíquicas y emocionales, ya que de otra manera no se 
pueden excluir lesiones o daños de objetos. El empresario u operador es responsable de seleccionar 
el personal usuario apto para el manejo del producto. 

2. Antes de desplazar o transportar el producto, lea y tenga en cuenta el capítulo "Transporte". 

3. Como con todo producto de fabricación industrial no puede quedar excluida en general la posibilidad 
de que se produzcan alergias provocadas por algunos materiales empleados ―los llamados 
alérgenos (p. ej. el níquel)―. Si durante el manejo de productos Rohde & Schwarz se producen 
reacciones alérgicas, como p. ej. irritaciones cutáneas, estornudos continuos, enrojecimiento de la 
conjuntiva o dificultades respiratorias, debe avisarse inmediatamente a un médico para investigar las 
causas y evitar cualquier molestia o daño a la salud.  

4. Antes de la manipulación mecánica y/o térmica o el desmontaje del producto, debe tenerse en cuenta 
imprescindiblemente el capítulo "Eliminación/protección del medio ambiente", punto 1. 

5. Ciertos productos, como p. ej. las instalaciones de radiocomunicación RF, pueden a causa de su 
función natural, emitir una radiación electromagnética aumentada. Deben tomarse todas las medidas 
necesarias para la protección de las mujeres embarazadas. También las personas con marcapasos 
pueden correr peligro a causa de la radiación electromagnética. El empresario/operador tiene la 
obligación de evaluar y señalizar las áreas de trabajo en las que exista un riesgo elevado de 
exposición a radiaciones. 

6. Tenga en cuenta que en caso de incendio pueden desprenderse del producto sustancias tóxicas 
(gases, líquidos etc.) que pueden generar daños a la salud. Por eso, en caso de incendio deben 
usarse medidas adecuadas, como p. ej. máscaras antigás e indumentaria de protección. 

7. Los productos con láser están provistos de indicaciones de advertencia normalizadas en función de la 
clase de láser del que se trate. Los rayos láser pueden provocar daños de tipo biológico a causa de 
las propiedades de su radiación y debido a su concentración extrema de potencia electromagnética. 
En caso de que un producto Rohde & Schwarz contenga un producto láser (p. ej. un lector de 
CD/DVD), no debe usarse ninguna otra configuración o función aparte de las descritas en la 
documentación del producto, a fin de evitar lesiones (p. ej. debidas a irradiación láser). 

8. Clases CEM (según CISPR 11) 
Clase A: dispositivo apropiado para el uso en cualquier zona excepto en áreas residenciales y en 
aquellas zonas que se encuentran conectadas a una red de suministro de baja tensión que alimenta 
un edificio de viviendas. 
Clase B: dispositivo apropiado para el uso en áreas residenciales y en aquellas zonas que se 
encuentran conectadas a una red de suministro de baja tensión que alimenta un edificio de viviendas. 

Reparación y mantenimiento 

1. El producto solamente debe ser abierto por personal especializado con autorización para ello. Antes 
de manipular el producto o abrirlo, es obligatorio desconectarlo de la tensión de alimentación, para 
evitar toda posibilidad de choque eléctrico.  
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2. El ajuste, el cambio de partes, el mantenimiento y la reparación deberán ser efectuadas solamente 
por electricistas autorizados por Rohde & Schwarz. Si se reponen partes con importancia para los 
aspectos de seguridad (p. ej. el enchufe, los transformadores o los fusibles), solamente podrán ser 
sustituidos por partes originales. Después de cada cambio de partes relevantes para la seguridad 
deberá realizarse un control de seguridad (control a primera vista, control del conductor de 
protección, medición de resistencia de aislamiento, medición de la corriente de fuga, control de 
funcionamiento). Con esto queda garantizada la seguridad del producto.  

Baterías y acumuladores o celdas 

Si no se siguen (o se siguen de modo insuficiente) las indicaciones en cuanto a las baterías y 
acumuladores o celdas, pueden producirse explosiones, incendios y/o lesiones graves con posible 
consecuencia de muerte. El manejo de baterías y acumuladores con electrolitos alcalinos (p. ej. celdas de 
litio) debe seguir el estándar EN 62133. 

1. No deben desmontarse, abrirse ni triturarse las celdas.  

2. Las celdas o baterías no deben someterse a calor ni fuego. Debe evitarse el almacenamiento a la luz 
directa del sol. Las celdas y baterías deben mantenerse limpias y secas. Limpiar las conexiones 
sucias con un paño seco y limpio. 

3. Las celdas o baterías no deben cortocircuitarse. Es peligroso almacenar las celdas o baterías en 
estuches o cajones en cuyo interior puedan cortocircuitarse por contacto recíproco o por contacto con 
otros materiales conductores. No deben extraerse las celdas o baterías de sus embalajes originales 
hasta el momento en que vayan a utilizarse. 

4. Las celdas o baterías no deben someterse a impactos mecánicos fuertes indebidos. 

5. En caso de falta de estanqueidad de una celda, el líquido vertido no debe entrar en contacto con la 
piel ni los ojos. Si se produce contacto, lavar con agua abundante la zona afectada y avisar a un 
médico. 

6. En caso de cambio o recarga inadecuados, las celdas o baterías que contienen electrolitos alcalinos 
(p. ej. las celdas de litio) pueden explotar. Para garantizar la seguridad del producto, las celdas o 
baterías solo deben ser sustituidas por el tipo Rohde & Schwarz correspondiente (ver lista de 
recambios).  

7. Las baterías y celdas deben reciclarse y no deben tirarse a la basura doméstica. Las baterías o 
acumuladores que contienen plomo, mercurio o cadmio deben tratarse como residuos especiales. 
Respete en esta relación las normas nacionales de eliminación y reciclaje.  

Transporte 

1. El producto puede tener un peso elevado. Por eso es necesario desplazarlo o transportarlo con 
precaución y, si es necesario, usando un sistema de elevación adecuado (p. ej. una carretilla 
elevadora), a fin de evitar lesiones en la espalda u otros daños personales.  

2. Las asas instaladas en los productos sirven solamente de ayuda para el transporte del producto por 
personas. Por eso no está permitido utilizar las asas para la sujeción en o sobre medios de transporte 
como p. ej. grúas, carretillas elevadoras de horquilla, carros etc. Es responsabilidad suya fijar los 
productos de manera segura a los medios de transporte o elevación. Para evitar daños personales o 
daños en el producto, siga las instrucciones de seguridad del fabricante del medio de transporte o 
elevación utilizado. 



Instrucciones de seguridad elementales 

1171.0000.42 - 06 Page 14 

3. Si se utiliza el producto dentro de un vehículo, recae de manera exclusiva en el conductor la 
responsabilidad de conducir el vehículo de manera segura y adecuada. El fabricante no asumirá 
ninguna responsabilidad por accidentes o colisiones. No utilice nunca el producto dentro de un 
vehículo en movimiento si esto pudiera distraer al conductor. Asegure el producto dentro del vehículo 
debidamente para evitar, en caso de un accidente, lesiones u otra clase de daños.  

Eliminación/protección del medio ambiente 

1. Los dispositivos marcados contienen una batería o un acumulador que no se debe desechar con los 
residuos domésticos sin clasificar, sino que debe ser recogido por separado. La eliminación se debe 
efectuar exclusivamente a través de un punto de recogida apropiado o del servicio de atención al 
cliente de Rohde & Schwarz. 

2. Los dispositivos eléctricos usados no se deben desechar con los residuos domésticos sin clasificar, 
sino que deben ser recogidos por separado. 
Rohde & Schwarz GmbH & Co.KG ha elaborado un concepto de eliminación de residuos y asume 
plenamente los deberes de recogida y eliminación para los fabricantes dentro de la UE. Para 
desechar el producto de manera respetuosa con el medio ambiente, diríjase a su servicio de atención 
al cliente de Rohde & Schwarz. 

3. Si se trabaja de manera mecánica y/o térmica cualquier producto o componente más allá del 
funcionamiento previsto, pueden liberarse sustancias peligrosas (polvos con contenido de metales 
pesados como p. ej. plomo, berilio o níquel). Por eso el producto solo debe ser desmontado por 
personal especializado con formación adecuada. Un desmontaje inadecuado puede ocasionar daños 
para la salud. Se deben tener en cuenta las directivas nacionales referentes a la eliminación de 
residuos. 

4. En caso de que durante el trato del producto se formen sustancias peligrosas o combustibles que 
deban tratarse como residuos especiales (p. ej. refrigerantes o aceites de motor con intervalos de 
cambio definidos), deben tenerse en cuenta las indicaciones de seguridad del fabricante de dichas 
sustancias y las normas regionales de eliminación de residuos. Tenga en cuenta también en caso 
necesario las indicaciones de seguridad especiales contenidas en la documentación del producto. La 
eliminación incorrecta de sustancias peligrosas o combustibles puede causar daños a la salud o 
daños al medio ambiente. 

Se puede encontrar más información sobre la protección del medio ambiente en la página web de 
Rohde & Schwarz. 
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CE Declaration of Conformity 

ROHDE & SCHWARZ GmbH & Co. KG 
Mühldorfstr. 15,  D-81671 München 
 
Munich, 2011-04-01  Central Quality Management GF-QP / Chadzelek 
 
1416.0505.02 CE E-1 

 

Certificate No.: 2011-11 
 

This is to certify that: 
 

Equipment type Stock No. Designation 
SGS100A 1416.0505.02 SGMA RF SOURCE BASE UNIT 
 

complies with the provisions of the Directive of the Council of the European Union on the 
approximation of the laws of the Member States  
 
- relating to electrical equipment for use within defined voltage limits  

(2006/95/EC) 
 
- relating to electromagnetic compatibility  

(2004/108/EC) 
 
Conformity is proven by compliance with the following standards: 
 
EN 61010-1: 2001 
EN 61326-1: 2006 
EN 61326-2-1: 2006 
EN 55011: 2007 + A2: 2007 
EN 61000-3-2: 2006 
EN 61000-3-3:2008 
 
For the assessment of electromagnetic compatibility, the limits of radio interference for Class 
B equipment as well as the immunity to interference for operation in industry have been used 
as a basis. 
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Customer Support 
 

Technical support – where and when you need it 
For quick, expert help with any Rohde & Schwarz equipment, contact one of our Customer Support 
Centers. A team of highly qualified engineers provides telephone support and will work with you to find a 
solution to your query on any aspect of the operation, programming or applications of Rohde & Schwarz 
equipment. 
 

Up-to-date information and upgrades 
To keep your instrument up-to-date and to be informed about new application notes related to your 
instrument, please send an e-mail to the Customer Support Center stating your instrument and your wish. 
We will take care that you will get the right information. 
 

Europe, Africa, Middle East Phone +49 89 4129 12345 
customersupport@rohde-schwarz.com

North America Phone 1-888-TEST-RSA (1-888-837-8772) 
customer.support@rsa.rohde-schwarz.com

Latin America Phone +1-410-910-7988 
customersupport.la@rohde-schwarz.com

Asia/Pacific Phone +65 65 13 04 88 
customersupport.asia@rohde-schwarz.com

China Phone +86-800-810-8228 /  
 +86-400-650-5896 
customersupport.china@rohde-schwarz.com

mailto:customersupport.asia@rohde-schwarz.com
mailto:customersupport.la@rohde-schwarz.com
mailto:customer.support@rsa.rohde-schwarz.com
mailto:customersupport@rohde-schwarz.com
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1 Preface
The R&S SGS RF Source is a signal generator intended either for the generation
of IQ-modulated signals or as a pure local oscillator (LO) source in the frequency
range of 1 MHz to 12.75 GHz.

Optimized for use in automated test equipment (ATE), the instrument offers very
fast settling times in an exceptionally small formfactor and low power consumption.
The R&S SGS can be equipped optionally with an active electronic step attenuator,
a high stability reference oscillator and LO connectors for coupling multiple gener-
ators to a common LO source.

1.1 Key Features

The key features of the R&S SGS include the following:

● Compact size and low power consumption
● Remote connection via PCI Express, minimizing time for setup

Alternatively, LAN or USB connections available
● Optional coherent LO input and output connectors, also usable as MIMO input/

output and phase coherent I/Q demodulation
● Broadband analogue input for vector modulation (I, Q)
● Linux operating system
● Graphical user interface R&S SGMA-GUI to set up and control one or more

R&S SGS instruments simultaneously from one remote computer, available for
Windows and Linux systems

1.2 Documentation Overview

The user documentation for the R&S SGS consists of the following parts:

● "Getting Started" printed manual
● Documentation CD-ROM with:

– Online help system (*.chm) as a standalone help
– User Manual for base unit and options

 

 

 

Key Features
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– Service manual
– Data sheet and product brochure
– Links to useful sites on the R&S internet

R&S SGMA-GUI Online Help

The Online Help is embedded in the R&S SGMA-GUI software. It offers quick, con-
text-sensitive access to the complete information needed for operation and pro-
gramming. The online help contains help on operating the R&S SGS and all avail-
able options.

Getting Started

This manual is delivered with the instrument in printed form and in PDF format on
the Documentation CD-ROM. It provides the information needed to set up and start
working with the instrument. Basic operations and typical measurement examples
are described. The manual includes also general information, e.g., safety instruc-
tions.

User Manual

The User Manual is a supplement to the Getting Started manual. The manual is
available in PDF format - in printable form - on the Documentation CD-ROM deliv-
ered with the instrument. In this manual, all instrument functions are described in
detail. Furthermore, it provides an introduction to remote control and a complete
description of the remote control commands with programming examples. Informa-
tion on maintenance, instrument interfaces and error messages is also given.

Service Manual

The Service Manual is available in PDF format - in printable form - on the docu-
mentation CD-ROM delivered with the instrument. It informs on how to check com-
pliance with rated specifications, on instrument function, repair, troubleshooting and
fault elimination. It contains all information required for repairing the instrument by
the replacement of modules.

1.3 Typographical Conventions

The following text markers are used throughout this documentation:

 

Typographical Conventions
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Convention Description

"Graphical user interface ele-
ments"

All names of graphical user interface elements on the screen, such
as dialog boxes, menus, options, buttons, and softkeys are
enclosed by quotation marks.

KEYS Key names are written in capital letters.

File names, commands,
program code

File names, commands, coding samples and screen output are
distinguished by their font.

Input Input to be entered by the user is displayed in italics.

​Links Links that you can click are displayed in blue font.

"References" References to other parts of the documentation are enclosed by
quotation marks.

Typographical Conventions
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2 Preparing for Use
This section describes the basic steps to be taken when setting up the R&S SGS
for the first time.

Risk of injury and instrument damage
The instrument must be used in an appropriate manner to prevent electric
shock, fire, personal injury, or damage.
● Do not open the instrument casing.
● Read and observe the "Basic Safety Instructions" at the beginning of this

manual or on the documentation CD-ROM, in addition to the safety instruc-
tions in the following sections. Notice that the data sheet may specify
additional operating conditions.

Risk of instrument damage
Note that the general safety instructions also contain information on operating
conditions that will prevent damage to the instrument. The instrument's data
sheet may contain additional operating conditions.
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Risk of instrument damage during operation
An unsuitable operating site or test setup can cause damage to the instrument
and to connected devices. Ensure the following operating conditions before
you switch on the instrument:
● All fan openings are unobstructed and the airflow perforations are unim-

peded. The minimum distance from the wall is 10 cm.
● The instrument is dry and shows no sign of condensation.
● The instrument is positioned as described in the following sections.
● The ambient temperature does not exceed the range specified in the data

sheet.
● Signal levels at the input connectors are all within the specified ranges.
● Signal outputs are correctly connected and are not overloaded.

Risk of electrostatic discharge
Protect the work area against electrostatic discharge to avoid damage to
electronic components in the modules. For details, refer to the safety instruc-
tions at the beginning of this manual.

EMI impact on measurement results
Electromagnetic interference (EMI) can affect the measurement results. To
avoid any impact, make sure that the following conditions are met:
● Use suitable double-shielded cables.
● Do not use USB connecting cables exceeding 1 m in length.
● Use only USB devices that remain within the permissible EMI limits.
● Always terminate any connected PCI Express/LAN cables with an instru-

ment or controller.

Outputs and lines have to be terminated properly with 50 Ohms.
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2.1 Unpacking and Checking the Instrument

To remove the instrument from its packaging and check the equipment for com-
pleteness proceed as follows:

1. Pull off the polyethylene protection pads from the instrument's rear feet and then
carefully remove the pads from the instrument handles at the front.

2. Pull off the corrugated cardboard cover that protects the rear of the instrument.

3. Carefully unthread the corrugated cardboard cover at the front that protects the
instrument handles and remove it.

4. Check the equipment for completeness using the delivery note and the acces-
sory lists for the various items.

5. Check the instrument for any damage. If there is damage, immediately contact
the carrier who delivered the instrument. Make sure not to discard the box and
packing material.

Packing material
Retain the original packing material. If the instrument needs to be transported
or shipped at a later date, you can use the material to protect the control
elements and connectors.

2.2 Placing or Mounting the Instrument

The R&S SGS is designed for use under laboratory conditions, either on a bench
top or in a rack using a rack adapter kit (order number see data sheet).

Bench Top Operation

If the R&S SGS is operated on a bench top, the surface should be flat. The instru-
ment can be used in horizontal position, standing on its feet.

Rackmounting

The R&S SGS can be installed in a rack using a rack adapter kit (Order No. see
data sheet). The installation instructions are part of the adapter kit.
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Risk of instrument damage in a rack
An unsufficient airflow can cause the instrument to overheat, which may dis-
turb the operation and even cause damage.
Make sure that all fan openings are unobstructed, that the airflow perforations
are unimpeded, and that the minimum distance from the wall is 10 cm.

2.3 Connecting the AC Supply

The R&S SGS is automatically adapted to the AC voltage supplied. There is no
need to set the voltage manually or change fuses. The ​AC SUPPLY AND POWER
SWITCH is at the rear of the unit.

► Connect the instrument to the AC power source using the AC power cable deliv-
ered with the instrument.
Note: The instrument is in compliance with safety class EN61010-1.
Connect the instrument only to a socket with earthing contact.

2.4 Switching the Instrument On and Off

2.4.1 Starting the Instrument

Switching off the AC power
You can leave the AC power on permanently to preserve your last instrument
settings. Switching off is required only if the instrument must be completely
disconnected from all power supplies.

Starting up the instrument

1. ​Connect the instrument to the AC supply.
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2. To turn the power on, press the main power switch to position I (On).
After power-up, the instrument is in standby or ready state, depending on the
state of the POWER ON/STANDBY key at the front panel of the instrument when
the instrument was switched off for the last time.

Switching between standby and ready state

► Press the POWER ON/STANDBY key briefly to switch the instrument from the
standby to ready state or vice versa.

In ready state, the button is green. The instrument is ready for operation. All
modules are power-supplied and the R&S SGS initiates its startup procedure.
In standby state, the button is orange. The standby power mode keeps the power
switch circuits and the remote control system active. In this state it is safe to
switch off the AC power and disconnect the instrument from the power supply.

Start-up and booting

The instrument boots the operating system and starts the instrument firmware. Dur-
ing the booting proccess the green POWER ON/STANDBY key blinks. If the pre-
vious session was terminated regularly, the instrument uses the last setup with the
relevant instrument settings.

Once the startup procedure has been terminated, the instrument is ready for oper-
ation.

In the R&S SGMA-GUI, select "Instrument > Preset" function to return the
instrument to its defined reset/preset state, if the current setup is no longer
relevant.

Switching the Instrument On and Off
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2.4.1.1 Function Check

The instrument automatically monitors the main functions when it is switched on
and continuously during operation.

A detected fault is indicated by an "Error" message displayed in the info line of the
R&S SGMA-GUI together with a brief error description. For in-depth identification
of the error, press the "SGMA-GUI > Info" button. In response, a description of the
error(s) is displayed. For more information, refer to the "Error Messages" section in
the User Manual.

In addition to the automatic monitoring, the R&S SGS offers the following capabili-
ties to ensure correct functioning:
● Internal Adjustments

In the R&S SGMA-GUI, select the "Instrument > Setup > Internal Adjust-
ments" dialog to access the dialog for performing and configuring the adjust-
ments settings. A maximum level accuracy can be obtained, for instance.

● Selftest
A selftest is provided for service purposes ("SGMA-GUI > Instrument > Diag-
nostic/Test > Self Test").

● Test points and Debug Page
If required for service purposes, internal test points and debug pages can be
queried. These tests are protected test procedures, which can be accessed if
protection level 4 is disabled. The corresponding procedure is described in the
Service Manual.

2.4.1.2 Default Settings

When the instrument is switched on, it is not the preset state that is active, but rather
the instrument state that was set before the instrument was switched off. It is rec-
ommended that you use the "SGMA-GUI > Instrument > Preset" function to return
the instrument to its defined preset state every time a new configuration is required
or the current setup is no longer relevant.

The R&S SGS offers a two-stage preset concept:
● Preset the instrument to a predefined state

The "SGMA-GUI > Instrument Name > Preset" function calls up a defined instru-
ment setup. All parameters and switching states are preset (also those of inac-
tive operating modes). The default instrument settings provide a reproducible
initial basis for all other settings. However, functions that concern the integration
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of the instrument into a measurement setup are not changed, e.g. reference
oscillator source settings.

● Preset the instrument to its factory settings
The instrument can also be forced to load its default factory settings. To access
the corresponding dialog box, select the "SGMA-GUI > Instrument Name >
Setup > Factory Preset" function.
For more information and an overview of the settings affected by the factory
preset function, see the "Factory Preset" section in the User Manual.

User-defined instrument states can be stored and called up using the func-
tions "SGMA-GUI > File > Save As/Open".

2.4.2 Shutting Down the Instrument

To shut down the R&S SGS, proceed as described below.

Risk of losing data
If you switch off the running instrument using the rear panel switch or by dis-
connecting the power cord, the instrument loses its current settings. Further-
more, program data may be lost.
Always press the POWER key first to shut down the application properly.

1. Press the POWER ON/STANDBY key to save the current setup, shut down the
operating system and set the instrument to standby state.
The POWER ON/STANDBY LED must be orange.
Tip: If the instrument is operated manually via the R&S SGMA-GUI, select
"SGMA-GUI > Instrument Name > Setup > Standby".

2. To turn the power off, press the main power switch to position 0 (Off).

None of the front-panel LEDs should be on.
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Switching off the AC power
You can leave the AC power on permanently to preserve your last instrument
settings. Switching off is required only if the instrument must be completely
disconnected from all power supplies.

2.5 Connecting an External PC and Devices

As a rule, the R&S SGS is operated exclusively via remote control on a connected
PC. Another way to control the instrument is the manual operation via the R&S
SGMA-GUI software on the connected PC.

Both the remote control and the manual operation of the instrument require an
external controller. For the prerequisites and the instructions on how to configure
an external controller for remote control, refer to the User Manual. A brief introduc-
tion to the remote control capabilities is provided in ​chapter 5.2, "Remote Control
Operation", on page 38.

This section gives an introduction on how to configure the external PC for manual
operation (see ​chapter 2.5.1, "Installing the R&S SGMA-GUI Software on the Exter-
nal PC", on page 15).

In addition to connecting an external controller, it may be useful to connect other
external devices, e.g. a memory stick. The following interfaces are provided on the
rear panel of the instrument, see also ​chapter 3.2, "Rear Panel
Tour", on page 26:

● PCI Express (refer to ​chapter 2.5.3, "Connecting a Remote PC via PCI
Express", on page 21

● USB interface (refer to ​chapter 2.5.4, "Connecting USB Devices or a Remote
PC via USB", on page 22)

● LAN interface (refer to ​chapter 2.5.2, "Connecting a Remote PC via
LAN", on page 17)

2.5.1 Installing the R&S SGMA-GUI Software on the External PC

R&S SGMA-GUI is delivered in the latest version available on the CD-ROM included
in the instrument's delivery. Software updates as well as the Release Notes describ-
ing the improvements and modifications are provided on the Internet at the down-
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load site of the Rohde&Schwarz home page. This home page always offers the
latest information on your R&S SGMA-GUI.

The R&S SGMA-GUI software is provided as separate installation package
for the different operating systems.
This description focuses on the handling of the Windows-32 version. The file
naming convetions and the installation istrtuctions for the other operating
systems are analogous.

The R&S SGMA-GUI installation package for Windows-32 operating system con-
sists of the file SGMA-GUI_<V.VV.VVV.VVV>.msi. The version numbers in the
file names vary with each update. To install R&S SGMA-GUI, the following hardware
and software requirements have to be met.

Table 2-1: Hardware and Software Requirements

Requirement Remark

One of the following operating
systems:

● Windows XP SP2
● Windows Vista
● Windows 7
● Linux

R&S SGMA-GUI has to be installed on one of the supported
operating systems.
Note:
Any other Windows version or other operating systems are not
supported.
During installation, the operation system is checked.
The installation will be terminated if this requirement is not ful-
filled.

National Instruments (NI) VISA
version 3.4.1 or higher (optional)
or
Agilent VISA version 14 or
higher (optional)

VISA drivers can be obtained from R&S or NI directly.

CPU At least Pentium or compatible, as from 1 GHz (recommended).

VGA color display resolution At least 800*600 pixels

Installing a new software version

Administrator rights are necessary for installation and starting.

► In Windows Explorer double-click SGMA-GUI_V.VV.VVV.VVV.msi and follow
the instructions.

Connecting an External PC and Devices



Preparing for UseR&S®SGS100A

17Getting Started 1416.0570.02 ─ 04

Uninstalling an old software version

An uninstallation of a previous version of the SW can be performed prior to the
installation of the new one but is not mandatory.

► To uninstall this version, go to "Start > Settings > Control Panel > Add/Remove
Programs" and select the entry SGMA-GUI_V.VV.VVV.VVV.

The script file identifies and removes all currently installed R&S signal generator
software items.

2.5.2 Connecting a Remote PC via LAN

The R&S SGS is equipped with a network interface and can be connected to an
Ethernet LAN (local area network). The interface can be used, for example:

● To connect an external computer for manual control of the instrument by means
of the R&S SGMA-GUI software.

● To operate the device by a remote control program.
See ​chapter 5.2, "Remote Control Operation", on page 38.

This section describes how to configure the LAN interface. It includes the following
topics:

● ​chapter 2.5.2.1, "Connecting the Instrument to the Network", on page 17
● ​chapter 2.5.2.2, "Assigning the IP Address", on page 18
● ​chapter 2.5.2.3, "Adding the instrument to R&S SGMA-GUI", on page 19

2.5.2.1 Connecting the Instrument to the Network

There are two methods to establish a LAN connection to the instrument:

● A non-dedicated network (Ethernet) connection from the instrument to an exist-
ing network made with an ordinary RJ-45 network cable. The instrument is
assigned an IP address and can coexist with a computer and with other hosts
on the same network.

● A dedicated network connection (Point-to-point connection) between the instru-
ment and a single computer made with a RJ-45 network cable. The computer
must be equipped with a network adapter and is directly connected to the instru-
ment. The use of hubs, switches, or gateways is not required, however, data
transfer is still performed using the TCP/IP protocol.
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In both cases, an IP address has to be assigned to the instrument and the computer,
see ​chapter 2.5.2.2, "Assigning the IP Address", on page 18.

Risk of network failure
Before connecting the instrument to the network or configuring the network,
consult your network administrator. Errors may affect the entire network.

Setting Up a Network (LAN) Connection

► Connect the instrument to the network.
a) To establish a non-dedicated network connection, connect a commercial

RJ-45 cable to the LAN port of the instrument and to the existing network.
b) To establish a dedicated connection, connect a RJ-45 cable between the

instrument and a single PC.
If the instrument is connected to the LAN, the operating system automatically
detects the network connection and activates the required drivers.
By default, the instrument is configured to use dynamic TCP/IP configuration
and obtain all address information automatically.
The green LAN LED on the front panel of the instrument is on.

2.5.2.2 Assigning the IP Address

Depending on the network capacities, the TCP/IP address information for the instru-
ment can be obtained in different ways.
● If the network supports dynamic TCP/IP configuration using the Dynamic Host

Configuration Protocol (DHCP), all address information can be assigned auto-
matically.

● If the network does not support DHCP, the instrument tries to obtain the IP
address via Zeroconf (APIPA) protocol. If this attempt does not succeed or if the
instrument is set to use alternate TCP/IP configuration, the addresses must be
set manually.

The R&S SGS uses the Zeroconf IP addresses 169.254.xxx.yyy., where xxx
may take values between 1...254 and yyy the values in the value range
1...255; the subnet mask is always 255.255.0.0. The IP address of the host
must be within the same address area for Zeroconf.
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By default, the instrument is configured to use dynamic TCP/IP configuration and
obtain all address information automatically. This means that it is safe to establish
a physical connection to the LAN without any previous instrument configuration.

2.5.2.3 Adding the instrument to R&S SGMA-GUI

For information on how to install the R&S SGMA-GUI software, refer to ​chap-
ter 2.5.1, "Installing the R&S SGMA-GUI Software on the External
PC", on page 15.

1. On the remote PC, open the R&S SGMA-GUI software and select "Setup >
Instruments".

The "Configure Instruments" dialog opens.

2. Perform "Configure Instruments > Scan".
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Tip: The first initialization of a newly connected instrument in a network and the
instrument's request to the DHCP server for an IP address may take some time.
During this time, the instrument does not respond to the query sent by the scan
function. If the instrument does not appear in the list of "Available Instruments",
trigger the scan function again after some minutes.
The software triggers a scan function and searches for instruments connected
to this remote PC via all of the available interfaces.
The list of all "Available Instruments" is updated.

R&S SGMA-GUI obtains all information for connecting to the instrument, so fur-
ther configuration is not necessary.

3. In the list of the "Available Instruments", select the instrument and activate it.

Connecting an External PC and Devices
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A new row with the main settings of the instrument is displayed on the main panel
of R&S SGMA-GUI. A green indicator in front of the instrument's name confirms
that the instrument is ready for operation.

2.5.3 Connecting a Remote PC via PCI Express

A PCI Express connector is provided on the rear panel of the instrument, see ​chap-
ter 3.2, "Rear Panel Tour", on page 26.

Risk of device failure
The R&S SGS is equipped with a single lane PCIe interface that supports hot
plug-in.
Do not connect an external PC to the PCIe connector of the instrument during
operation if this external PC does not support hot-plugging!

 

Connecting an External PC and Devices



Preparing for UseR&S®SGS100A

22Getting Started 1416.0570.02 ─ 04

Using the PCIe interface for remote control of the instrument requires exten-
ded knowledge and is described in section "Advanced Remote Control via
PCIe" in the User Manual.

2.5.4 Connecting USB Devices or a Remote PC via USB

The USB interface on the rear panel of the R&S SGS allows you to connect either
a USB device or use the instrument as a USB device and connect it to a host PC.

Connecting a remote PC

An external PC with installed R&S SGMA-GUI on it is required for manual operation
of the instrument. To connect the external controller to the USB interface of the
instrument, use a standard USB cable with Type A and Type Micro-B connectors.

On the remote PC, perform the steps as described in ​chapter 2.5.2.3, "Adding the
instrument to R&S SGMA-GUI", on page 19.

Connecting a memory stick or CD-ROM drive

The following list shows various USB devices that can be useful. The number of
devices can be increased as necessary by using a USB hub.
● Memory stick for easy transfer of data to/from a computer (e.g. firmware

updates, USB install, etc.)
● CD-ROM drives for easy installation of firmware applications

All USB devices can be connected to or disconnected from the instrument during
operation.

2.6 Linux Operating System

The instrument uses a Linux operating system. To ensure that the instrument soft-
ware functions properly, certain rules must be adhered to concerning the operating
system.

The configuration of the operating system is optimally adapted to signal generator
functions in the factory. Changes in the system setup are only required when
peripherals are installed or if the network configuration does not comply with the
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default settings. After the R&S SGS is started, the operating system boots and the
instrument firmware is started automatically.

Accessing the Operating System
No access to the operating system is required for normal operation.
All neccessary system settings can be made in the "Setup" dialog.

The R&S SGS provides an internal flash memory, it does not contain a disk drive.
The flash memory holds the operating system, the firmware and the stored data.
Data transfer is possible via a memory stick connected to a USB interface. The
memory stick and the flash memory are accessed via the "SGMA-GUI > File" func-
tion.

Accessing the File System

The instrument also supports two standard methods to access the file system form
a remote client:
● FTP (file transfer protocol)
● File sharing according to the SAMBA/SMB (server message block) protocol.

Both methods allow the access to the folder /var/user/share.

Default password
The FTP and SAMBA file access use the user "instrument" with default pass-
word "instrument".
It is highly recommended to change this password in the "SGMA-GUI > Setup
> Security > Change User Password" dialog before connecting the instrument
to the network!

Linux Operating System
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3 Instrument Tour
The following topics will help you get familiar with the instrument and perform the
first steps:
● ​Front Panel Tour
● ​Rear Panel Tour

This section explains the control elements and connectors of the R&S SGS with the
aid of the front and rear views. Specifications of interfaces can be found in the data
sheet.

3.1 Front Panel Tour

This section provides an overview of control elements on the front panel of the
R&S SGS. The connectors of the R&S SGS are placed on the rear panel and are
described in ​chapter 3.2, "Rear Panel Tour", on page 26. As the R&S SGS is
mainly intended to be remote-controlled, the front panel of the R&S SGS contains
no display but mostly LEDs to inform the user about the status of the instrument.
The user interface can be displayed on a remote PC station used to manually remote
control the instrument.

Fig. 3-1: Front panel view

POWER ON/STANDBY

The POWER ON/STANDBY key switches the instrument from the standby to ready
state or vice versa.
In ready state, the button is green. The instrument is ready for operation.
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In standby state, the button is orange. The standby power mode keeps the power
switch circuits and the remote control system active. In this state it is safe to switch
off the AC power and disconnect the instrument from the power supply.
A blinking green color indicates that a booting operation is in proccess.

RF ON

The RF ON key switches the RF signal on or off. If activated, the button is green.

LAN

Pressing the key for more than 3 s resets the LAN interface settings, i.e the "IP
Adress Mode" is reset to DHCP.

REF EXT

The REF EXT LED indicates the status of the external reference.
● Green indicates that the instrument can synchronize to the external clock.
● Red indicates that the instrument cannot synchronize to the external clock.
● No light indicates that the internal reference is used.

ERROR / WARNING

The ERROR / WARNING LED indicates the status of the R&S SGS.
● Red indicates that an error has occurred, e.g. temperature exceeded or power

failure.
● Blinking Orange indicates a running calibration process.
● No light indicates that no errors or warnings have occurred.
For details on errors or warnings refer to the graphical user interface on a remote
PC ("SGMA-GUI > Info").
For more information, refer to the "Error Messages" section in the User Manual.

Front Panel Tour
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ID

Pressing the ID key opens the "SGMA-GUI > Setup > Instruments > Configure
Instruments > Edit Instrument" dialog of the corresponding instrument on the remote
controller.

3.2 Rear Panel Tour

This section provides an overview of connectors on the rear panel of the instrument.
For technical data of the connectors refer to the data sheet.

Fig. 3-2: Rear panel view

Protection of mechanical components
To avoid damage of the SMA connectors it is essential to limit the tightening
torque to 60 Ncm. Use an adequate 8 mm torque wrench and not an ordinary
open-end wrench.

PCI EXPRESS CONNECTOR

The PCIe (Peripheral Component Interconnect Express) single lane interface allows
for remote control with optimized speed.
For details see ​chapter 2.5.3, "Connecting a Remote PC via PCI
Express", on page 21.
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USB CONNECTOR

The USB (universal serial bus) interface, Type Micro, allows you to connect various
external devices, e.g.:
● If the instrument is used as a device, a remote computer can be connected for

firmware update, manual operation via the R&S SGMA-GUI software or for
remote control of the instrument.

● If the instrument is used as a host, a memory stick for file transmission can be
connected.

For details see ​chapter 2.5.4, "Connecting USB Devices or a Remote PC via
USB", on page 22.

LAN CONNECTOR

The LAN (Ethernet) interface allows you to connect the R&S SGS to other devices,
e.g. a remote computer for firmware update, manual operation via the R&S SGMA-
GUI software or for remote control of the instrument. The connection to the remote
computer can be direct or via a network.
For details see ​chapter 2.5.2, "Connecting a Remote PC via LAN", on page 17.

RF OUT

The RF OUT connector provides RF 50 Ohm signal output.
NOTICE! Maximum Input Levels. Do not overload the RF output. The maximum
permissible back-feed is specified in the data sheet.

Rear Panel Tour
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REF / LO IN, REF / LO OUT

The REF/LO OUT and REF/LO IN connectors can be used either for reference or
local oscillator signals, and alternatively also in MIMO setups.
Reference input and output:
● REF IN: Input for external reference signal.
● REF OUT: Output of internal reference signal.
Local oscillator input and output:
● LO IN: Input for external LO signals
● LO OUT: Output for internal LO signals.
Note: The Local Oscillator input/output requires the additional software option
R&S SGS-K90.

TRIG

Multi purpose connector provided for future use.

I , Q

The I and Q connectors are the inputs of the I/Q modulator, provided for feeding of
external signal.
NOTICE! Maximum Input Levels. Do not overload the I and Q inputs. The maximum
permissible voltage is 1V. For details, refer to the data sheet.
Note: The I/Q modulator requires the hardware option R&S SGS-B106V.

AC SUPPLY AND POWER SWITCH

Rear Panel Tour
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The AC supply and power switch allow you to connect the R&S SGS to the power
supply and switch on the instrument.
For details see ​chapter 2.3, "Connecting the AC Supply", on page 11.

Rear Panel Tour
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4 First steps with the Instrument
This section provides an example on how to configure the instrument to generate
a continuous wave (CW) signal. The instrument is manually operated via the R&S
SGMA-GUI software.

The R&S SGS in this example is a base unit equipped with the frequency option
R&S SGS-B106.

Configuring the R&S SGS to generate a CW signal

As a prerequisite for this example, the R&S SGS has to be connected to a remote
PC. The R&S SGMA-GUI software has to be installed on this remote PC and the
instrument is added to the list of "Available Instruments".

Fig. 4-1: Example of setup

For information on how to fulfill these requirements, refer to
● ​chapter 2.5.2.1, "Connecting the Instrument to the Network", on page 17
● ​chapter 2.5.1, "Installing the R&S SGMA-GUI Software on the External

PC", on page 15
● ​chapter 2.5.2.3, "Adding the instrument to R&S SGMA-GUI", on page 19

1. Check the front panel of the R&S SGS.
The POWER ON/STANDBY and LAN key have to be green; all other buttons
are off.

2. On the connected remote PC, start the R&S SGMA-GUI software application.
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The main panel of the application opens. The panel provides a quick access to
the main settings of the configured and activated instruments. The display shows
one row per instrument with the instrument specific settings. The rows comprise
the instrument, the connection state, the used frequency and power level, the
state of the RF output and the modulator and the used reference frequency
source.

3. If several instruments have been configured in the R&S SGMA-GUI, press the
ID button on the instrument's front panel to trigger device identification.
The "Edit Instrument" dialog of this instrument opens.

Field "Edit Instrument > Symbolic Name" displays the name of the instrument
as shown in the R&S SGMA-GUI main panel.
Tip: Dialog "Edit Instrument" does not appear.
If this dialog does not open, perform the following:
● Check whether the instrument is correctly connected to the external PC on

which you work with the R&S SGMA-GUI.
● Check if the instrument is configured in the R&S SGMA-GUI and perform, if

necessary, the steps described in ​chapter 2.5.2.3, "Adding the instrument to
R&S SGMA-GUI", on page 19.
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● Select "SGMA-GUI > Setup > Instruments", check the state of the instrument
in the "Configure Instruments > Available Instruments" table and activate it,
if disabled.

4. In the R&S SGMA-GUI main panel, the green indicator in front of the instrument's
name confirms that there is a connection between the instrument and the remote
PC and that the instrument is recognized by the software.

5. In the R&S SGMA-GUI main panel, select the row corresponding to the instru-
ment to be configured and select "Instrument Name > Preset" to restore the
predefined instrument's settings.
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6. In the R&S SGMA-GUI main panel, select the row corresponding to the instru-
ment to be configured and adjust the "Frequency" as required.

7. Select "SGMA-GUI > RF On" to enable the output of the CW signal.

The 5 GHz signal is output at the RF OUT connector at the rear panel of the
R&S SGS.

Connect RF OUT of the R&S SGS to a signal analyzer to display the gener-
ated signal.
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Identifying an instrument in a network
To identify the instrument in a big network, use one of the device identification
functions, e.g. select "SGMA-GUI > Instrument Name > Setup > Remote >
Remote Channels > Device Identify".
The green LAN LED on the front panel of the instrument blinks.
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5 Instrument Control
As a rule, the R&S SGS is operated exclusively via programmatic remote control
from a connected PC. For service and diagnostic tasks, as well as for manual con-
figuration, a graphical user interface (R&S SGMA-GUI) is provided which runs on
the remote PC.

Additionally, some basic functionality is provided via the keys on the front panel of
the instrument (see ​chapter 3.1, "Front Panel Tour", on page 24).

5.1 Manual Operation via R&S SGMA-GUI

The R&S SGMA-GUI software application can be installed on a PC with Windows
or Linux operating system. This program allows you to control several devices of
the SGMA product family at the same time and to monitor the device status during
remote control. R&S SGMA-GUI requires one of the external interfaces described
in ​chapter 2.5, "Connecting an External PC and Devices", on page 15.

5.1.1 Introduction to the User Interface

After the start of R&S SGMA-GUI the main dialog of the application is displayed.

Fig. 5-1: Example of R&S SGMA-GUI

The main dialog with the overview of the configured instruments is the operating
and control interface for the whole program. From here, all program functions are
accessible.

The menus and dialogs are built using elements like selection lists, check boxes,
and entry fields. A blue frame indicates that the selected item is active. Entries can
be made in the highlighted element.
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The main dialog comprises two main areas:
● On the top of the main panel, there are the menu bar, the tool bar and the info

bar with the corresponding "Info" button.
The menu bar provides access to the functions related to the software applica-
tion itself, like saving current configurations, resetting the display, retrieving
information about the installed software version or configuring the connected
instruments.
The messages displayed in the info line indicate information, warnings, and
errors. They are displayed in different colors depending on their importance and
display duration. Use the "Info" button to open a dialog with information on the
messages in greater detail.

● The central part of the R&S SGMA-GUI main dialog is the main panel that shows
the list of all active instruments.
The main panel is the core element for the manual operation and provides quick
access to the main settings of the configured instruments. The display shows
one row per active instrument. Each row comprises the instrument's name and
state, the used frequency and level, the state of the RF output and the modulator
and the kind of used frequency reference.
The buttons with the instrument's symbolic name on it provides access to menus
and dialogs for further instrument configuration. Refer to the User Manual for
detailed description of all parameters and functions provided for configuration.

A detailed description of the R&S SGMA-GUI, in depth information on how to
work with the application and on how to operate the R&S SGS and perform
general configuration tasks is provided in the User Manual.

5.1.2 How to Use the Help System

The R&S SGMA-GUI is equipped with a context-sensitive help function. A help page
is available for each parameter and can be called any time during instrument oper-
ation.

Compiled online help systems are also available on the CD-ROM supplied
with the instrument. This help program can be called on any controller with
Internet Explorer version V4.0 and higher.
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Calling context-sensitive and general help

► To display the general help dialog box, select the "SGMA-GUI > Help > Con-
tents" or use the F1 key.
The help dialog is displayed. A topic containing information about the current
menu or the currently opened dialog box and its function is displayed.

Contents of the help dialog box

The help dialog box contains two main areas:
● "Contents" - contains a table of help contents
● "Topic" - contains a specific help topic

The help system additionally provides an "Index" and a "Find" area, as well as
"Zoom" functions that are accessed by means of the corresponding buttons.

Navigating in the table of contents and in the help topics

1. To move through the displayed contents entries, use the mouse or the UP/
DOWN keys. Entries that contain further entries are marked with a plus sign.

2. To display a help topic, double click on the topic name or press the ENTER key.

3. To jump to the linked topic, press the link text.

4. Use the "Previous" or "Next" links to jump to the corresponding topic.

5. Use the "Scroll Right" or "Scroll Left" buttons to shift the indicated area of the
navigation window to the left or right.

Manual Operation via R&S SGMA-GUI
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Using the Index

1. Select "SGMA-GUI > Help > Index" or use the "Go to Index" button in the
"Help" display.

2. Enter the first characters of the topic you are interested in. The entries starting
with these characters are displayed.

3. Press the ENTER key to display the help topic.

The corresponding help topic is displayed.

5.2 Remote Control Operation

As an alternative to operating the R&S SGS interactively via the R&S SIGMA-GUI,
one can also be controll the R&S SGS using programmed commands from a remote
PC.

5.2.1 Remote Control Interfaces and Protocols

The instrument supports several interfaces for remote control. The following table
gives an overview.
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Table 5-1: Remote control interfaces and protocols

Interface Protocols Remarks

Local Area
Network
(LAN)

● HiSLIP High-Speed LAN Instrument Protocol
(IVI-6.1)

● VXI-11
● socket communication (Raw Ethernet, simple Tel-

net)

A LAN connector is located
on the rear panel of the
instrument.
The interface is based on
TCP/IP and supports vari-
ous protocols.
For details see ​chap-
ter 5.2.1.1, "LAN Inter-
face", on page 39

USB USBTMC A USB connector is located
on the rear panel of the
instrument.
For details see ​chap-
ter 5.2.1.2, "USB Inter-
face", on page 41

PCIe Proprietary A PCIe connector is located
on the rear panel of the
instrument.
For details see ​chap-
ter 5.2.1.3, "PCI Express
Interface", on page 41

SCPI (Standard Commands for Programmable Instruments)

SCPI commands are used for remote control. Commands that are not taken from
the SCPI standard follow the SCPI syntax rules. The instrument supports the SCPI
version 1999. The SCPI standard is based on standard IEEE 488.2 and aims at the
standardization of device-specific commands, error handling and the status regis-
ters. The tutorial "Automatic Measurement Control - A tutorial on SCPI and IEEE
488.2" from John M. Pieper (R&S order number 0002.3536.00) offers detailed infor-
mation on concepts and definitions of SCPI.

5.2.1.1 LAN Interface

To be integrated in a LAN, the instrument is equipped with a LAN interface, con-
sisting of a connector, a network interface card and protocols. For remote control
via a network, the PC and the instrument must be connected via the LAN interface
to a common network with TCP/IP network protocol. They are connected using a
commercial RJ45 cable. The TCP/IP network protocol and the associated network
services are preconfigured on the instrument. Software for instrument control and
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the VISA program library (for specified protocols only) must be installed on the con-
troller.

Only the IP address or the computer name (LAN device name) is required to set up
the connection. The IP address/computer name is part of the "VISA resource string"
used by the programs to identify and control the instrument.

Identifying instruments in a network
If several instruments are connected to the network, each instrument has its
own IP address and associated resource string. The controller identifies these
instruments by means of the resource string.

HiSLIP Protocol

The HiSLIP (High Speed LAN Instrument Protocol) is the successor protocol for
VXI-11 for TCP-based instruments specified by the IVI foundation. The protocol
uses two TCP sockets for a single connection - one for fast data transfer, the other
for non-sequential control commands (e.g. Device Clear or SRQ).

HiSLIP has the following characteristics:

● High performance as with raw socket network connections
● Compatible IEEE 488.2 support for Message Exchange Protocol, Device Clear,

Serial Poll, Remote/Local, Trigger, and Service Request
● Uses a single IANA registered port (4880), which simplifies the configuration of

firewalls
● Supports simultaneous access of multiple users by providing versatile locking

mechanisms
● Usable for IPv6 or IPv4 networks

Note that HiSLIP data is sent to the device using the "fire and forget" method
with immediate return, as opposed to VXI-11, where each operation is blocked
until a VXI-11 device handshake returns. Thus, a successful return of a VISA
operation such as viWrite() does not guarantee that the instrument has
finished or started the requested command, but is delivered to the TCP/IP
buffers.

Remote Control Operation
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VXI-11 Protocol

The VXI-11 standard is based on the ONC RPC (Open Network Computing Remote
Procedure Call) protocol which in turn relies on TCP/IP as the network/transport
layer. The TCP/IP network protocol and the associated network services are pre-
configured. TCP/IP ensures connection-oriented communication, where the order
of the exchanged messages is adhered to and interrupted links are identified. With
this protocol, messages cannot be lost.

Socket Communication

An alternative way for remote control of the software is to establish a simple network
communication using sockets. The socket communication, also referred to as “Raw
Ethernet communication”, does not necessary require a VISA installation on the
remote controller side.

The simplest way to establish socket communication is to use the built-in telnet
program. The telnet program is part of every operating system and supports com-
munication with the software on a command-by-command basis.

Socket connections are established on a specially defined port. The socket address
is a combination of the IP address or the host name of the instrument and the num-
ber of the port configured for remote-control. All instruments use port number 5025
for this purpose. The port is configured for communication on a command-to-com-
mand basis and for remote control from a program running on a connected PC.

5.2.1.2 USB Interface

For remote control via USB connection, the PC and the instrument must be con-
nected via the USB interface. A USB connection requires the VISA library to be
installed. VISA detects and configures the R&S instrument automatically when the
USB connection is established. You do not have to install a separate driver.

5.2.1.3 PCI Express Interface

A PCI Express (PCIe) connector is provided on the rear panel of the instrument.

Via PCI Express some commands can be sent to the instrument with optimized
speed (memory-mapped remote control), e.g. frequency or level settings. This
allows for minimum setup time.
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Using the PCIe interface for remote control of the instrument requires exten-
ded knowledge and is described in section "Advanced Remote Control via
PCIe" in the User Manual.

5.2.2 Example: Remote Control over LAN using the VXI-11 Pro-
tocol

In the following example, the program "Measurement & Automation Explorer" from
National Instruments is used on a Windows operating system to set up a LAN
remote control link and to start a remote control session. The remote control pro-
gram "Measurement & Automation Explorer" opens the connection to the instrument
(using VISA functionality) and then sends commands to and receives device
responses from the instrument.

A remote control connection requires a VISA installation but no additional hardware
on the controller PC. The LAN I/O channel is selected at initialization time using the
VISA resource string (also referred to as "address string"). A VISA alias (short
name) is generally used to replace the complete resource string. The host address
is either the R&S SGS's computer name or its IP address.

Proceed as described in ​chapter 2.5.2.2, "Assigning the IP Address", on page 18
to determine the relevant address information.

In this example, it is assumed that:
● a LAN remote control link between the controller and the R&S SGS is

already set up.
For information on setting up the link see ​chapter 2.5.2, "Connecting a
Remote PC via LAN", on page 17.

● a VISA and the "Measurement & Automation Explorer" program are instal-
led on the remote PC.
For detailed information, refer to section "Remote Control Basics" in the
User Manual or to the online help of the "Measurement & Automation
Explorer" program.
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Configuring the controller

The instrument is preconfigured for networks using DHCP (dynamic host
configuration protocol). If this configuration is used, enter the computer name
in the position of the IP address.

To enable the external controller to communicate with the software via TCP/IP pro-
tocol, set up a remote control link as follows:

1. Connect the controller and the instrument to the network (network cable) and
switch them on.

2. Start the 'Measurement & Automation Control' program on the controller.

3. Select "Devices and Interfaces > Create New".

4. Select "VISA TCP/IP Resource" and confirm with "Next".

5. Choose the type of TCP/IP resource you wish to add and select "Next".

Remote Control Operation
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6. Enter the IP address or the host name of the R&S SGS and select "Next".

7. Enter the alias name if required.
The alias name must not be mistaken for the computer name. It is only used for
instrument identification within the program and displayed in the menu as an
option in case of an Ethernet link.

8. Confirm the settings with "Finish".
The instrument is configured and the settings are displayed in the "TCP/IP Set-
tings" tab.

9. To test the connection, select "Validate".
A message indicates whether the link to the instrument can be set up or not.

Remote Control Operation
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If a connection cannot be set up, check whether the controller and the instrument
are connected to the network (network cable) and are switched on. Correct
spelling of the IP address or the computer name should be checked. For further
error location, inform the network administrator. In large networks, specification
of additional addresses may be required for link setup, e.g. gateway and subnet
mask, which are known to the network administrator.

The instrument is now registered in the program and can be addressed via the
resource string or alias name.

Starting a remote control session over LAN (using VXI-11)

1. Start the "Measurement & Automation Explorer" on the controller.

2. In the "Configuration" window, select "Device and Interfaces > VISA TCP/IP
Resources", select the required instrument and select "Open VISA Test
Panel".

3. In the "viWrite" tab, write the command to be sent to the instrument and select
"Execute".

Remote Control Operation
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Instrument responses are displayed on the "viRead" tab.
Tip: For further program operation refer to the online help of the program.

Remote Control Operation



IndexR&S®SGS100A

47Getting Started 1416.0570.02 ─ 04

Index 

A

AC supply ........................................ 11, 28

C

Connector
I .......................................................... 28
LAN .................................................... 27
LO IN ................................................ 28
LO OUT ............................................ 28
PCIe .................................................. 26
Q ........................................................ 28
REF IN .............................................. 28
REF OUT .......................................... 28
RF OUT ............................................ 27
TRIG .................................................. 28
USB .................................................. 27

Connectors ............................................ 26

D

Default instrument settings .................... 13
DHCP .................................................... 18

E

Error
Key .................................................... 25

External controller .................................. 15
External devices .................................... 15
External reference

Connector .................................... 25, 28

F

Function check ...................................... 13

H

Hardware
Requirements .................................... 16

HiSLIP .................................................... 38
Protocol .............................................. 40

I

I / Q
Connectors ........................................ 28

ID
Key .................................................... 26

Input/Output connector .......................... 28
Input connector ...................................... 28

Installing
Hardware .......................................... 16
R&S SGMA-GUI ................................ 15
Requirements .................................... 16
Software ............................................ 16
Uninstalling the old version ................ 15
Update .............................................. 15

Interfaces
USB .................................................. 41

IP address .............................................. 40
Changing .......................................... 18

K

Key
ID ...................................................... 26
LAN .................................................... 25
POWER ON/STANDBY .................... 24
RF ON ................................................ 25

L

LAN
Configuration .................................... 17
Connector .......................................... 27
Interface ............................................ 39
IP address .......................................... 40
Key .................................................... 25
VXI protocol ...................................... 41

LED
ERROR / WARNING ........................ 25
REF EXT ............................................ 25

Linux ...................................................... 22
LO

Connector .......................................... 28

M

MIMO
Connector .......................................... 28

O

Online help
Working with ...................................... 36

Operating system .................................. 22
Option

R&S SGS-B106V .............................. 28
R&S SGS-K90 .................................. 28

Output connector .................................... 28



IndexR&S®SGS100A

48Getting Started 1416.0570.02 ─ 04

P

PCIe
Connecting ........................................ 21
Connector .......................................... 26

Point-to-point connection ........................ 17
Power On

Key .................................................... 24
Power switch .................................... 11, 28
Preset instrument settings ...................... 13
Protocol

VXI .................................................... 41

R

Rackmounting ........................................ 10
Ready state ............................................ 12
REF

Connector .......................................... 28
REF EXT

Key .................................................... 25
Remote control

connect .............................................. 38
Reset instrument settings ...................... 13
RF 50 Ohm

Connector .......................................... 27
RF ON

Key .................................................... 25

S

SCPI
Version .............................................. 39

Shutting down ........................................ 14
Socet ...................................................... 38
Software

Requirements .................................... 16
VISA driver ........................................ 16

Standby .................................................. 12
Key .................................................... 24

T

Telnet .................................................... 38
Trigger

Connector .......................................... 28

U

Updating R&S SGMA-GUI .................... 15
USB

Connecting ........................................ 22
Connector .......................................... 27
Interfaces .......................................... 41

V

VISA ...................................................... 38
Resource string .................................. 40

VXI-11 .................................................... 38
VXI protocol ............................................ 41


	Title
	Safety Instructions and General Information
	Basic Safety Instructions
	Instrucciones de seguridad elementales
	Certificate of Quality
	CE Declaration of Conformity
	Customer Support

	Contents
	1 Preface
	1.1 Key Features
	1.2 Documentation Overview
	1.3 Typographical Conventions

	2 Preparing for Use
	2.1 Unpacking and Checking the Instrument
	2.2 Placing or Mounting the Instrument
	2.3 Connecting the AC Supply
	2.4 Switching the Instrument On and Off
	2.4.1 Starting the Instrument
	2.4.1.1 Function Check
	2.4.1.2 Default Settings

	2.4.2 Shutting Down the Instrument

	2.5 Connecting an External PC and Devices
	2.5.1 Installing the R&S SGMA-GUI Software on the External PC
	2.5.2 Connecting a Remote PC via LAN
	2.5.2.1 Connecting the Instrument to the Network
	2.5.2.2 Assigning the IP Address
	2.5.2.3 Adding the instrument to R&S SGMA-GUI

	2.5.3 Connecting a Remote PC via PCI Express
	2.5.4 Connecting USB Devices or a Remote PC via USB

	2.6 Linux Operating System

	3 Instrument Tour
	3.1 Front Panel Tour
	3.2 Rear Panel Tour

	4 First steps with the Instrument
	5 Instrument Control
	5.1 Manual Operation via R&S SGMA-GUI
	5.1.1 Introduction to the User Interface
	5.1.2 How to Use the Help System

	5.2 Remote Control Operation
	5.2.1 Remote Control Interfaces and Protocols
	5.2.1.1 LAN Interface
	HiSLIP Protocol
	VXI-11 Protocol
	Socket Communication

	5.2.1.2 USB Interface
	5.2.1.3 PCI Express Interface

	5.2.2 Example: Remote Control over LAN using the VXI-11 Protocol


	 Index



